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Chapter 1. General

1.1. Introduction

This document describes how to use the DC Maintenance Management System (DCMMYS) application
version 2.0.4.

DCMMS is a web-based application that allows to record and analyze maintenance and repair activit-
ies of water utilities. GIS (Geographic Information System) functionality plays a central rolein the ap-
plication (map-based repair location).

DCMMSis available from http://dcmms.sour ceforge.net.
Additional information is available in the DCMMS administration and devel opment guides.

New users are advised to read at least Section 1.2, “Requirements’, Section 1.3, “User Interface” and
Chapter 2, Quick Start.

The DCMMS User Guide is available in different formats (PDF, HTML, CHM and DocBook XML)
and different languages (Arabic, English and French).

1.1.1. What's New?

Changes introduced by the latest DCMMS version.
The history of changes introduced by older versionsis available in Chapter 5, History.
The following changesin version 2.0.4 are relevant to the users:

Information banner has been added to display the pending workorder for each administrative area.

Workorders can be catagorized based on network.

Email address can be entered as part of the complainant information.

Date format has been changed from having one single text box to enter the date to a multiple drop down list with
thefollowing format " YYYY-MM-dd hh:mi".

Workorder printing sheet has been changed to respond to language.

Workorder printing sheet has extra items added:" I nspected”

Inspected has been added to workorder status list.

Firefox page setup instructions have been added to the user guide (See Section 3.10.2, “Firefox Page Setup”).
"Socket", "Male PE Compression Fitting", "Female PE Compression Fitting" and "90° Elbow" have been added to
thelist of materials.

"Manhol€e" has been added as a possible leak location.

New maintenance types "Meter sealing”,"No action: Material not available", and "Welding action done" have
been added.

"Material not available" has been added as a cause.

"Substandard Construction™ has been added to Workorder type list.

New function "decmmesversion()" has been added.

The size of the note and location description fields has been doubled.

Leaked quantity has been added as part of the maintenance information

Received workorders report: adjusted to include the total number of received workorders, and to have these
workorders listed ascending order.

Pending complaints report: adjusted, and re-organized to display the pending complaints based on their catagories.
User Activity report: A new report added to show the user's activity, introduced as a monitoring tool.

L eaked water amount: A new report to document the leaked water amounts.

Response time report: adjusted to show the avarage reponse time for all teams.

Resource report: adjusted to give a better overview of the costing

Quality control report: More validations have been added.

Workorder detailed status report: A new report have introduced to show the workorder status, and the reson of the
pending workorders.
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1.2. Requirements

In order to run the DCMMS you need a web browser like Internet Explorer or Mozlla Firefox and the
address (URL) of a DCMMS server. Contact your DCMMS administrator if you need help.

If you are running DCMMS on a standalone system, you should be able to start the DCMMS applica
tion from the Start Menu or with a Shortcut on your Desktop.

1.3. User Interface

1.3.1.

1.3.2.

1.3.3.

This section introduces important concepts of the DCMMS user interface.

Navigation

A consistent navigation structure guides through the application. Through the "DCMMS' link in the
navigation bar at thetop it is always possible to return back to the main page (main menu).

Logoff, workorder and landmark search and help functions are available at the top of each page.

Languages

The DCMMS application is fully internationalized. Y ou can switch to the language of your choice us-
ing the select box at the top of the page.

DCMMSiscurrently available in the following languages:

» Arabic
» Syrian Arabic
e English
* French
e ltalian
e Thai

Additional languages can be easily added. If the language you are looking for is missing, please con-
tact the DCMMS devel opers.

Ask your DCMMS administrator to enable one of the above languages if necessary.

Find

Thefind tool in the navigation bar allows to search for workorders and landmarks.

Workorder number or landmark name have to be entered to the text field. Pressing Enter or clicking

on the Find button next to the data entry field will start the search for the landmark or workorder num-
ber.

Tip
DCMMS administrators can extend the find tool through plug-ins. One such plug-in is

the customer search plug-in that alows to zoom to customer locations using their sub-
scription number. See Section 3.15.1, “ Customer Search Plug-In” for details.
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1.3.4.

1.3.5.

1.3.6.

1.3.7.

1.3.8.

Field Descriptions

The DCMMS application helps you to fill in the forms correctly by providing an intuitive help: If you
leave the mouse cursor without movement over afield, ahelp message will be displayed.

Pager Navigation

Where database queries return too many results to display on the screen, DCMMS will offer a pager
navigation that allows to browse through all the records. This concept is used for example in the zoom
(Section 3.4, “Zoom Page”) and workorder list (Section 3.6, “Workorder”) pages.

A pager looks like the following:

Di splaying [110 - 200] of 220
<< Back[(10 20 30 Next >>[1

The number of the first displayed record.

The number of the last displayed record.

The total number of records than can be displayed using the pager.
A link to go to the previous set of records.

A link to go to thefirst set of records.

A text indicating that the second set of recordsis displayed.

A link to go to the third set of records.

A link to go to the next set of records.

Ooooooooo

Context Sensitive Help

Context sensitive help is available on every page by clicking on Help link in the navigation bar.

The user guide will be opened in the language that is currently selected in the DCMMS application.

0 Note

If no documentation is available in the language that is selected in the application, an er-
ror message might be displayed by the browser.

Try to switch to another language in this case (Section 1.3.2, “Languages’). Then click
on the help link again.

The chapter describing the current page will be opened in the DCMMS user guide.

ISO Date and Timestamp Format

Dates and timestamps are as defined in the 1SO format: YYYY-MM-DD HH:mm
For example: 2006-01-23 09:14

Required Fields

Wherever fields are mandatory in forms, they are marked with ared *.

These fields have to be filled in order to submit the form successfully.

1.4. Feedback

The DCMMS application needs your ideas for improvement. Please submit your comments to the de-
velopers, either by email of through the RFE (Request For Enhancement) tracker on the project web-
site (http://sourceforge.net/projectsdcmms/).

3
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Alternatively, you can send an email to <dcrmms- i nf o@ i st s. sour cef or ge. net >.




Chapter 2. Quick Start

This section gives you a short introduction into the main features of DCMMS. Nevertheless it is re-
commended to read the whole user guide.

2.1. Logon

Open the DCMM S logon page in your browser. This can be done by

e Double-clicking on the DCMMS link on your desktop
* If you don't have a DCMMS link on your desktop, open your web browser (Mozlla Firefox or In-
ternet Explorer) and enter the URL provided by your DCMMS administrator. If you are using a
stand-alone installation, the URL is most probably http://localhost/decmms/
On the logon page you have to enter your username and password in the respective fields.
Username and password should have been provided by your DCMMS administrator.
Tip

Ask your DCMMS administrator to create a bookmark for the logon page of the
DCMMS application.

2.2. Create a Workorder

In order to create aworkorder you should perform the following steps:

e Pressthe Zoomlink in the main page.

» Select alandmark and press the Map link. There are various options to select the landmark as out-
lined in Section 3.4, “Zoom Page’.

. ﬂ Make sure that the workorder tool is enabled. Only one tool is enabled at atime. You can
(= ]|

enable atool by clicking on the radio button next to the tool icon.

» Choose the area of interest center point by clicking onto the map. The area of interest is the area
where you expect the maintenance problem.

. f: The workorder tool icon changes to indicate that you have to defines the area of interest ra-
(=]

dius now. Do so by clicking on the map again.
e Click onthe [ Accept Area of Interest] link.
* Insert the appropriate information and then press the Save button.

Note that fields marked with ared "*" are mandatory (see Section 1.3.8, “Required Fields”).
* Now print this page and hand it over to the maintenance team.

e Click on the map to get back to the main page.
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2.3. Field Work

The maintenance team foreman hasto fill in the workorder sheet in the field. This includes marking of
the pipe on which the maintenance has been performed in case that this is missing on the map.

2.4. Maintenance Data Entry

Once the maintenance team has returned from the field, the information from the workorder sheet
should be entered to the system by following the steps below:

e Enter the number of the returned workorder sheet in the find tool (navigation bar, see Sec-
tion 1.3.3, “Find") and press enter or click on the Find button.

« Inthetable of pending workorders, click on the Map link in the sameline.

. Select the Locate Maintenance tool.

* Locate the maintenance by clicking on the map.

. Click the Accept Maintenance Location link.

< Update the maintenance record by entering the appropriate information as recorded on the sheet.

* Now you can enter more information about staff working hours, equipment used, material spent
and seal s broken.

* Click on the DCMMSIink to get to the main page.
2.5. Reporting
To get an overview on the maintenance activities, follow the steps below to create areport:

« Now click the Reportslink.

» Click the Workorder Status Report link to get information about all existing workorders.




Chapter 3. Reference
3.1. Procedures

The following procedures should be applied in order to operate DCMMS successfully.

3.1.1. Problem Reporting

Problems operating the DCMMS system have to be documented by filling in a DCMMS Downtime
Monitoring Sheet.

The following information has to be recorded:

« Who had the problem?
*  When did the problem occur?

e A detailed description of the problem.

| mportant

A The DCMMS Downtime Monitoring sheet has to be submitted to the DCMMS adminis-
trator on aweekly basis.

3.2. Frequently Asked Questions (FAQ)

This section tries to answer to frequently asked questions regarding the usage of DCMMS.

3.2.1. Why are there so many generic terms (I would like
to see more specific terms) ?

Instead of using specific terms like "On main pipe", one should use "On pipe" and enter the diameter
that isinvolved. This allows much better analysis of the data and is much less error prone. Your field
personnel may have a different understanding what amain pipeis. But they'll all know the diameter of
the pipe.

Another example would be a maintenance type like "Main Valve Repair”. Instead of such a specific
term, the maintenace type "Repair should be used in combination with the valve diameter and the leak
location "On Valve".

Tip

The flexible combination of several generic terms in the application allows to cover
highly specific cases.

3.2.2. Why is it not possible to select "On Main Valve"
or "On Main Pipe" any more?

Newer DCMMS versions use more generic terms like "On Pipe" or "On Valve" because they are more
flexible.

See Section 3.2.1, “Why are there so many generic terms (I would like to see more specific terms) 7’

7
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3.2.3.

for details.

How can | prevent the browser from saving my

password?

3.2.4.

3.2.5.

This depends on the browser version.

For Mozilla Firefox, follow the steps below:

1. Select Tools->Options....

2. Select Privacy.

3. Expand the "Saved Passwords' information by clicking on the + icon next to it.
4. Click onthe Clear button to erase al previously saved passwords.

5. Disable the checkbox next to "Save Passwords’

6. Click OK.

Why is the workorder # not always sequential?

The application is "recycling" workorder numbers where the data entry process was not completed.

It would also be possible to have completely sequential workorder numbers, but this would lead to
gaps in the sequence and thus misleading workorder numbers that are higher than the total number of
complaints recorded.

The reports make it easy to sort the workorders by any criteriaincluding the date they were received.

Can | create custom reports in Excel?

Yes of course. All reports are HTML reports than can be easily opened in Excel for further pro-
cessing.

Just create the report that contains the information you are interested in, save it in the browser and
openitin Excel.

3.3. Main Page

The main page contains the main menu of the DCMMS application.

This page can be reached from any page in the application by clicking on the DCMMS link in the nav-
igation bar (Section 1.3.1, “Navigation”).

The following links are displayed:

Zoom Y ou can zoom to landmarks here (Section 3.4, “Zoom Page”).
Map Allows you to explore the map.

Workorders Follow up existing workorders and maintenance records.
Reports Reports generated from the maintenance data.

About DCMMS DCMMS copyright information.

If you are logged on to the DCMMS application as an administrator, additional administration tools
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will be available. These tools are described in Section 3.14, “ Administration”.

3.4. Zoom Page

The zoom page contains several options to identify a maintenance location with the help of landmarks.

This page can be reached from any page in the application by using the find tool in the navigation bar
(Section 1.3.3, “Find").

By default all landmarks of an administrative area are displayed. If necessary, the pager elements
(Section 1.3.5, “Pager Navigation”) are displayed and allow to browse through the compl ete selection.

Thefirst option is to go through the dropdown lists to select the landmark you want to use:
Select the administrative areafrom the list and click on the Select button.

Select the village from the list and press the select button.

Select the landmark type from the list and press the select button.

Once your information has narrowed down the selection of landmarks sufficiently, you can select the
landmark from the table at the bottom of the page.

If you know the name of the landmark or a part of it, you can use Name box to enter this name.

The Fuzzy Name check box allow to specify a"fuzzy" search that will retrieve landmarks even if their
name is entered with a different spelling (E.g. "Irbid" will be returned even if "Irbed" was entered).

Note

If you don't know the complete name of the landmark, it is better not to activate the
Fuzzy Name search.

Once you've found the landmark you're looking for, click on the "Map" link next to it to view the area
around the landmark on the map.

Use the Details link to view (and edit) detailed landmark information (Section 3.12, “Landmark”).

3.5. Map

3.5.1.

The map page allows to edit map information for workorders and landmarks as well as navigation of
the map and information retrieval for various map elements.

This page can be reached from the main page (Section 3.3, “Main Page”), the zoom page (Section 3.4,
“Zoom Page”), the workorder page (Section 3.7, “Workorder Details’) or the landmark page (Sec-
tion 3.12, “Landmark”) as well as some of the reports.

Legend The legend allows to hide some layers from being displayed on the map. Removing the check-
mark next to the layer will remove the layer from the map the next time the map is redrawn.

Quick View A dropdown list that allows to quickly display a certain area or the full extent.
Keymap Y ou can use the keymap to pan the map.

Map Size Use this dropdown list to select the size of the map.

Tools

The following map tools are available:
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Gl Zoom In Use thistool to decrease the map extent.
Q Zoom Out Use thistool to increase the map extent.
$ Pan Use thistool to recenter the map. The map will be centered around the click point.

[:} Identify use this tool to see information about features on the map. Your administrator might

use plug-ins to deliver custom information (e.g. images) for the identified features.

Landmark use this tool to add landmarks to the map. The tool is also used to view detailed land-

mark information and edit landmarks (See Section 3.12, “Landmark”).

Workorder (Center) Use this tool to select the workorder's area of interest (See Section 2.2,
ol

“Create a Workorder”.

o Note

The tools work without double-click and rubber-banding. Select a tool and click one
time on the map. Depending on server, internet connection and complexity of the map,
loading the new map might take afew seconds.

3.6. Workorder

3.6.1.

Aninventory of all documented and scheduled maintenance works.

This page can be reached from Section 3.3, “Main Page’, Section 3.11, “Maintenance” or Section 3.7,
“Workorder Details’.

The Pending and Completed tabs allow to switch the display (Section 3.6.1, “Pending Workorders’,
Section 3.6.2, “Completed Workorders”).

Pending Workorders

Lists all the currently pending (open) workorders.

If necessary, pager elements (Section 1.3.5, “Pager Navigation”) are displayed on the page to allow to
browse through all records.

In the Action column of the table, links allow to view detailed information related to the workorder:

e Map - view the area of interest on the map. Use this to edit the maintenance location (Section 3.5,
“Map”).

* View - view and edit the information that was recorded for this workorder (Section 3.7,
“Workorder Details’).

* Maintenance - view and edit maintenance information recorded for this workorder (Section 3.11,
“Maintenance”).

e Print - print another copy of the workorder (Section 3.10, “Print Workorder”).

10
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* Resource - View and edit resource information related to the workorder (Section 3.8, “ Resource”).

The Map link should be used to complete a workorder after the maintenance team has returned from
thefield.

3.6.2. Completed Workorders

A list of all workordersthat have been completed.

Use the links next to the workorders in order to retrieve additional information (See Section 3.6,
“Workorder”).

3.7. Workorder Detalls

To enter a new workorder, start in Section 3.5, “Map”, digitize the workorder's area of interest using
the workorder tool and click on the Accept Area of Interest link.

Fill in the following workorder information:

* Network Type: The network that the workorder is dealing with (water or waste water).

e Type: Thetype of problem that is reported in this workorder. One of the following:

Leak - A leak in the network.

No Water - Customer receives no water. Only applicable for water supply. In case aleak is
causing the customer not to receive water, the type "No Water" shall be used.

This also includes cases where the customer is receiving less water than expected or the ser-
vice pressure islow.

Pollution - Polluted water is received by the customer. Only applicable to water supply. In case
aleak is causing a pollution, the type "Pollution" shall be selected.

Other - A workorder that cannot be described by the other types. In this case an additional de-
scription of the problem shall be added to the Location Description field.

Blockage - A blockage is troubling the network operation. Applicable to water and waste wa-
ter networks. If the customer receives no water and a blockage is suspected as the cause,
"Blockage" shall be selected.

Flooding - Flooding was caused by water or wastewater networks.

Damaged Installation - A part of the network is damaged and needs replacement or repair.
Illegal Use - The network isused illegally. Applicable to water and wastewater networks.
Wrong Bill - The customer thinks that the issued bill is wrong.

No Bill - The customer didn't receive abill.

Wrong Reading - The customer thinks that the reading figure on the bill is wrong.

Subscription Change - The customer wants to change the subscription.

Unregistered Payment - A payment wasn't registered.

Substandard Construction - A substandard construction.

e Complainant: The name of the person that provided the information for this workorder. Shall be
contacted later on if additional information is needed.
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» Telephone: Contact information for the complainant - telephone number or email address.
e E-Mail: Contact information for the complainant - email address.

« Location Description: Additiona information that describes location and nature of the problem.
E.g. "Theleak can be found under the big oak tree"

« Date Received: The date and time when the workorder was received. The system provides a de-
fault value, but this value has to be adjusted e.g. when the system was down or the workorder is
not entered directly to the system.

Click the Save button once the information has been entered in order to go to Section 3.10, “Print
Workorder”.

3.8. Resource

3.8.1.

3.8.2.

3.8.3.

3.8.4.

Four resource categories are available: Staff, material equipment and seal.

These pages can be reached from Section 3.7, “Workorder Details’, Section 3.6, “Workorder”, Sec-
tion 3.11, “Maintenance”.

These pages allow to record in detail which resources have been used to perform the maintenance.

Staff

Allowsto record the working hours of different types of staff that completed a given workorder.

Material

Allows to record quantities and diameters of different materials that have been used to perform a
maintenance activity.

Equipment

Allows to record which type of equipment has been used to perform a maintenance activity (including
working hours and cost center).

Seal

Re-establishing broken seals is a priority. For this reason, the seal page together with Section 3.9.2.6,
“Broken Seals Report” provide al relevant information for this topic.

3.9. Reports

3.9.1.

Thisisthe main page for the reports, al DCMMS reports are accessible through this page.

Workorder Reports

Reports related to the workorder records.

3.9.1.1. Workorder Status Report

Y ou can use this report to display information about all workorders within a period of time.

It is possible to generate the report only for an selected administrative area.
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3.9.1.2. Workorder Detailed Status Report

Y ou can use this report to display information about all workorders within a period of time.

This report generates information for the workorders status for the selected period,the number of in-
spected, and the pending workorders because of unavailability of material.

It is possible to generate the report only for an selected administrative area.

3.9.1.3. Pending Complaints Report

Y ou can use this report to query all the pending workorders and to display detailed information about
them.

It is possible to generate the report only for one administrative area.

3.9.1.4. Received Workorders Report

Y ou can use this report to query al the Received workorders within a period of time

It is possible to generate the report only for one administrative area.

3.9.1.5. Pending Workorders

Report the individual workorders that are currently still pending catogrized based on workorder type.
This report can be generated for a forman, or the inspector.

3.9.1.6. Pending Workorders By Team

Report the individual workorders that are currently assigned to the teams.

3.9.1.7. Query Workorder Status

Query a specific workorder.
Workorder number or complainant name can be entered to search the workorder.
Tip
Use the find tool in the navigation bar to search workorders by number (Section 1.3.3,

“Find").

3.9.1.8. Aging Report

Report workorder aging over a period of time.

Input of the mandatory fields Count (e.g. 7), Interval (e.g. days) and End Date (e.g. 2006-01-25 00:00)
should be read like this: Create the aging report for the period of 7 days before January 25, 2006.

The selection of administrative area and workorder type information is optional. If one of them is se-
lected, the report will be limited accordingly.

Tip

This report is a useful tool to analyze trends in the maintenance works (E.g.: Are
workorders piling up?).

3.9.1.9. Completed Workorders Report
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Report workorders that have been closed during a period of time.

The report lists workorder 1D, complainant, description, telephone number, location description, date
received and note for al workorders of status "Closed" for a given period of time.

The report can be generated for all areas or a selected administrative area.

3.9.1.10. User Activity Report

Report the individual user's activities.

3.9.2. Maintenance Reports
3.9.2.1. Maintenance By Team

Report the individual workorders that were closed by the teams withing a given period of time.

3.9.2.2. Leaked Water Report

Report the Total leaked quantitiesin each administrative area, and the total leaked amounts.

3.9.2.3. Response Time Report
Calculate the average response time for a given period of time.
The detailed analysisis broken down by adminstrative area and team.

The response time is defined as the difference between the timestamp when the workorder was re-
ceived and the timestamp when the maintenance was compl eted.

3.9.2.4. Excavation Report
Information about the areas that have been excavated and repaved during the repairs.
The report is generated for a period of time which needs to be defined by two timestamps.

It is possible to generate the report only for one administrative area

3.9.2.5. Resource Report
Information about the resources that have been used for maintenance.
Thereport is generated for a period of time which needs to be defined by two timestamps.

It is possible to generate the report only for one administrative area.

3.9.2.6. Broken Seals Report

Information on seals that were broken during the maintenance activities.
The report is generated for a period of time which needs to be defined by two timestamps.
It is possible to generate the report only for one administrative area.

See also Section 3.8.4, “Seal”.

3.9.2.7. Quantity Report

Report the amount of installed PE pipe for a certain period of time. The statistics can be broken down
by administrative area.
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3.9.3. Other Reports

3.9.3.1. Full Report
All recorded data.
The report is generated for a period of time which needs to be defined by two timestamps.
Caution
A Depending on the amount of data recorded and the selected period of time, the report

generation can take a long time. If you are facing timeout problems, try generating the
report for a shorter period.

3.9.3.2. Quality Control Report

This report should be used to verify the quality of the entered information.

3.9.3.3. Monthly Management Report
An executive summary containing selected parameters for one month from the system.

All figures reflect the selected month except the two "Number of Open Workorder" figures. They re-
port the total number of open workorders at the end of the selected month.

3.9.3.4. Team Report

A report listing all maintenance teams including their types and assigned administrative areas.

3.10. Print Workorder

The "Print Workorder" page displays the workorder for printing. The browser's print dialog is auto-
matically opened.

This page is opened after the initial recording of the workorder (Section 3.7, “Workorder Details’). It
can also be reached by clicking on the Print link in one of the following pages. Section 3.6,
“Workorder”, Section 3.7, “Workorder Details’, Section 3.11, “Maintenance”.

A click on the map returns to the main page (Section 3.3, “Main Page”.

3.10.1. Filling in the Workorder Sheet

The maintenance team foreman has to fill in the workorder sheet in the field. This includes marking of
the pipe on which the maintenance has been performed in case that thisis missing on the map.

3.10.2. Firefox Page Setup

Printing workorders requires a compact page setup.
To setup the pages using Firefox, select File->Page Setup... from the menu.

In the page setup dialog select "Landscape” and " Shrink to Fit to Page Width" as shown in Figure 3.1,
“Firefox Page Setup”.
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Page Setup E

Format & Options | Margins & Header [Footer |

Format

Scale: %o Shrink To Fit Page Width

Options
[] Print Background (colors & images)

QK | | Cancel

Figure 3.1. Firefox Page Setup

Then click on the Margins & Header/Footer tab and set al the margins to 0 as shown in Figure 3.2,
“Firefox Margin Setup”.
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X]

Page Setup

Format & Options | Margins & Header Footer |
Margins (inches)
Top: | N
Left: ' Right:
] : |0
Bottom: |0
Headers & Footers
—blank- | | -blank-- | | —blank-- w
Left: Center: Right:
—blank-- w | | —blank-- w | | —blank-- W
QK | | Cancel

Figure 3.2. Firefox Margin Setup

Set all header and footer items to "--blank--".

Click the OK button to confirm the page and margin setup.

3.11. Maintenance

This page provides the form that has to be filled in whenever a workorder has been completed. Thein-
formation has to be collected in the field on the workorder sheet.

The following maintenance types are available:

* No action: No supply scheduled - this should be selected when a no water complaint is received
but no supply is scheduled.

« Valve Operation - should be selected when the only maintenance operation performed was open-

ing or closing a valve. If other activities were performed, a different maintenance type should be
selected.
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3.12.

No action: Workorder duplicated - should be selected if the workorder was closed because the
same problem was recorded before in a different workorder. The respective workorder number
should be mentioned in the note field. However, this should not be selected if the problem occurs
again after the original workorder has been closed (The problem occurs again and is not only re-
ported multiple times).

No action: Not responsible - should be selected when the organization operating DCMMS is not
responsible for the required maintenance. Example: The customer is responsible if there is a leak
after the water meter.

Disconnection - should be selected when a physical disconnection of a pipe was performed. This
should not be selected if only avalve was closed.

Meter Sealing - should be selected when a physical meter sealing was done for meter.

No action: Material not available - should be selected when a maintenance can not be performed
due to the unavailability of material.

Welding action done - should be selected when a physical welding of a pipe was performed.

The leak location is the place where the repair was performed.

This page can be reached from Section 3.7, “Workorder Details’, Section 3.6, “Workorder”.

Landmark

Viewing and editing and deletion of landmark information.

| mportant

A You have to be a landmark editor in order to edit the landmark information (Sec-

tion 3.14.1, “User Management”).

Landmarks can also be moved on the map (Section 3.5, “Map”) .

This page can be reached through the View links in Section 3.4, “Zoom Page” and through the land-
mark tool in Section 3.5, “Map”.

3.13. Miscellaneous

Miscellaneous DCMMS functions.

3.13.1. About the DC Maintenance Management System

Copyright information for DCMMS and the software packages used by the application.

DCMMSis free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at
your option) any later version.

DCMMS isdistributed in the hope that it will be useful, but WITHOUT ANY WARRANTY ; without
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PUR-
POSE. See the GNU Genera Public License for more details.

The GNU General Public License (GPL) is available from http://www.gnu.org.

3.14. Administration
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This section describes functions that are only available to DCMMS administrators.
DCMMS administrators can access this functionality from the main page (Section 3.3, “Main Page”).

Administrators should also read the DCMMS Administration Guide.

3.14.1. User Management

Add and edit DCMMS users and their access rights.

A user is able to log on to the application.

Users can be assigned administrator rights. This assigns the PostgreSQL role "dcmmsadministrator"” to
them through which additional rights are given on the database level. In addition administrator func-
tions are available in the web interface through Section 3.3, “Main Page”.

DCMMS administrators can reach this page through Section 3.3, “Main Page’.

See Section 3.14, “Administration” for the administrator functions that are available through the web
interface.

User can be assigned the landmark editor role which allows them to edit and delete landmarks (Sec-
tion 3.12, “Landmark”).

3.14.2. Team Management

Add and edit maintenance teams.
Maintenance teams perform the actual maintenance works. Workorders are assigned to them.

DCMMS administrators can reach this page through Section 3.3, “Main Page”.

3.14.3. Remove Temporary Files

Allows to delete all filesinc: \tnmp and c: \ 't np\ ns_t np. All files that are older than one hour
will be deleted.

Administrators can reach this page through Section 3.3, “Main Page”.

3.14.4. Purge Workorder

Allows to delete a workorder and all related records (maintenance, staff, material, equipment, seal,
history).

The number of the workorder to be deleted has to be entered to the form.
Tip
The PL/SQL function pur gewor kor der (i nt wor kor deri d) isusedinternaly.
It can also be used in SQL queries. For example:

sel ect purgeworkorder(id) from workorder where id < 1000

DCMMS administrators can reach this page through Section 3.3, “Main Page”.

3.14.5. Analysis
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Allowsto spatially analyze the maintenance data.

Three different analysis types are available:

e Maintenance Density
e Per-pipe Density

e Per-connection Density

| mportant

A The per-pipe density analysis requires the pipe network to be loaded to the Pressurized-
Main table. Calculation of the per-connection density requires the Connection table. Y ou

can use the Gshp2pgsgl to load those files.
The functions automatically compress the analysis data by dropping those cells that don't contain any
data.

Instead of afixed cell size for the analysis, the resolution of the analysis data is specified. As aresult,
cell sizes and alignments that are changing dynamically with the recorded data.

Administrators reach this page from Section 3.3, “Main Page”.

3.14.6. Setup

Information on the setup of the DCMMS application.

Displays the languages that have been enabled on the application as well as on the database side.
Displays DCMMS pluginsthat are configured ini dent i f ypl ugi n.ini .

Displays available PEAR packages including version number.

Administrators can reach this page from Section 3.3, “Main Page”.

3.14.7. Translation Management

3.15.

Allows to update DCMMSS trand ations on the database side.

Administrators can reach this page from Section 3.3, “Main Page”.

Plug-Ins

Plug-ins are optional software components that allow the administrator to extend the application func-
tionality.

Currently DCMMS supports plug-ins for the navigation bar find tool (See Section 1.3.3, “Find”) and
the identify tool on the map page (See Section 3.5.1, “Tools").

0 Note

Because plug-ins are optional and depend on the configuration specified by the adminis-
trator, your DCMMS installation might not provide the functionality described in this
chapter.
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3.15.1. Customer Search Plug-In

The customer search plug-in extends the navigation bar find tool with functionality to zoom to cus-
tomer locations based on their subscription number.

The plug-in is executed when a keyword followed by a colon (":") is prepended to the search term
entered to the find tool.

The default keyword for the customer search is "customer"”, however, this might be changed by the ad-
ministrator. Example 3.1, “Search for customer with subscription number 311" shows an example
search using this default key word.

Example 3.1. Search for customer with subscription number 311

custoner: 311

If a matching customer is found, the map page will be zoomed to the customer location. In case no
matching customer is found, an error message is displayed.

21



Chapter 4. Troubleshooting

This chapter shows ways to get support for the DCMMS problems.

4.1. Common Problems

The most common problems when using DCMMS.

4.1.1. The Page Cannot be Displayed

If you encounter an error likein Figure 4.1, “The Page Cannot be Displayed”, the network connection
to the server might be lost. Check that the network cable is connected properly to your computer. If
the problem is not related to the network cable, contact your DCMMS administrator.

<23 Cannot find server, - Microsoft Internet Explorer E@g|
Iy
y

File Edit Wiew Favorites Tools  Help

A — N
&) > \ﬂ \ELI o 7/ ! Search < ¢ Favorites @e Tz = ’23

Address @j http:ff10,128.56.102{dcmmsflogon. php A a Go Links **

@ The page cannot be displayed

The page you are looking for is currently unavailable. The web
site might be experiencing technical difficulties, or you may need
to adjust your browser settings,

Please try the following:

» Click the Refresh button, or try again later,

» If you typed the page address in the Address bar, make

sure that it is spelled correctly.
# To check your connection settings, click the Tools menu,
and then click Internet Options. On the Connections
tab, click Settings. The settings should match those
provided by your local area network {LAN) administrator or
Internet service provider (ISP},
See if your Internet connection settings are being detected.
You can set Microsoft Windows to examine your network
and autornatically discover network connection settings (if
your networle administrator has enabled this setting).

1. Click the Tools menu, and then click Internet

Options,
2. ©Onthe Connections tab, click LAN Settings.
3. Select Automatically detect settings, and then
click DK.

Some sites require 128-bit connection security. Click the
Help menu and then click About Internet Explorer to
determine what strength security you have installed.,
s Tf wvni are trvinn tn reach a seeore site. make sore vonr

@;‘] Done B Internet

Figure4.1. The Page Cannot be Displayed

4.1.2. Workorders are not printed correctly
When the workorder are not printed correctly (e.g. the workorder is split across multiple pages or in

portrait instead of landscape orientation), make sure that you follow the page setup instructions (see
Section 3.10.2, “Firefox Page Setup”).

4.2. DCMMS Administrator

Contact your DCMMS administrator if you have any problems.
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4.3. DCMMS Info Mailing List

The DCMMS info mailing list may provide help to solve problems, either through the archives which
are available under http://sourceforge.net/mailar chive/forum.php?forum id=32901. or by sending an
email to<dcms-i nfo@i sts. sourcef orge. net >,

4.4. Support Tracker

The bug and support trackers are available through the DCMMS website, ht-
tp://dcmms.sour ceforge.net .

Caution

A Please make sure that you look at all support requests, not only the open ones.

4.5. Bug Reports

When submitting bug reports or support requests, try to be verbose. This will alow the administrators
or developers to reproduce the problem quickly and resolve it.

There are a few parameters that should always be included when submitting a bug report or support
request:
« The DCMMS version. The version number can be found in the top line of the application, along

with the main menu link. Example: DCMMS 1.0.1

« The user name used to log on to the application. The user name can be found in the top line of the
application in the Log off link.

« Error messages. If the system isissuing any error messages, please include these messages in your
report. Try to insert the error messages as text, not as screenshots because text can be found in
search engines.

* Give ashort description of what you were trying to do and how you expect the application to re-
act. Describe what the application is doing wrong.

4.6. Shapefile Loading Problems

When encountering problems after shapefiles have been loaded to PostGIS, use the DCMMS data
model to double check that the required fields of all tables are in place.
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Chapter 5. History

History of user-relevant changesin DCMMS.

Changesin the latest version arelisted in Section 1.1.1, “What's New?".

5.1. Version 2.0.4

The following changesin version 2.0.4 are relevant to the users:

Information banner has been added to display the pending workorder for each administrative area.

Workorders can be catagorized based on network.

Email address can be entered as part of the complainant information.

Date format has been changed from having one single text box to enter the date to a multiple drop down list with
thefollowing format " YYYY-MM-dd hh:mi".

Workorder printing sheet has been changed to respond to language.

Workorder printing sheet has extra items added:" I nspected”

Inspected has been added to workorder status list.

Firefox page setup instructions have been added to the user guide (See Section 3.10.2, “Firefox Page Setup”).
"Socket", "Male PE Compression Fitting", "Female PE Compression Fitting" and "90° Elbow" have been added to
thelist of materials.

"Manhol€e" has been added as a possible |eak |ocation.

New maintenance types "Meter sealing”,"No action: Material not available", and "Welding action done" have
been added.

"Material not available" has been added as a cause.

"Substandard Construction™ has been added to Workorder type list.

New function "demmesversion()" has been added.

The size of the note and location description fields has been doubled.

Leaked quantity has been added as part of the maintenance information

Received workorders report: adjusted to include the total number of received workorders, and to have these
workorders listed ascending order.

Pending complaints report: adjusted, and re-organized to display the pending complaints based on their catagories.
User Activity report: A new report added to show the user's activity, introduced as a monitoring tool.

Leaked water amount: A new report to document the leaked water amounts.

Response time report: adjusted to show the avarage reponse time for all teams.

Resource report: adjusted to give a better overview of the costing

Quality control report: More validations have been added.

Workorder detailed status report: A new report have introduced to show the workorder status, and the reson of the
pending workorders.

5.2. Version 1.1.2

Thefollowing changesin version 1.1.2 are relevant to the users:

New maintenance type "Disconnection”.

5.3. Version 1.1.1

Version 1.1.1 is a bug fix and maintenance release that does not contain any changes visible to the
user.

5.4.Version 1.1.0

The following changesin version 1.1.0 are relevant for the users:

New reports: Section 3.9.2.1, “Maintenance By Team”, Section 3.9.1.6, “ Pending Workorders By Team”.
Status information is moved from the workorder to maintenance data.
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History datais available from maintenance records.

Landmark searches will automatically become fuzzy if the accurate search does not return any results.
Resource report includes unit cost calculations.

Improved documentation.

Various bug fixes.

5.5. Version 1.0.5

Thefollowing changesin version 1.0.5 are relevant for the users:
Find tool in the navigation bar can also be used to search for landmarks.
Monthly management report contains the "completion ratio percentage”. The number formatting was improved.
For workorders and landmarks history data is available documenting changes over time.
New material type: Flow meter
A new "pending workorders' layer on the map allows to identify duplicate complaints.

Improved documentation.
Various bug fixes.

5.6. Version 1.0.4

The following new features were introduced in version 1.0.4:
Syrian Arabic trandations.

Simplified translation and landmark management system.
Improved shapefile loader and dumper.

Image Identify Plug-in.

New maintenance cause: Municipality

New maintenance type: Not responsible

Spatial analysis allows drilldown according to the workorder type.
Different maintenance team types: Inspector and maintenance team.
Users that are not administrators are able to edit landmarks.

New equipment types: Motorcycle and angle grinder.

New Workorder search option in title bar.

New quantity report summarizing the use of PE pipe.

New monthly management report.

Documentation improvements.

Various bug fixes.

5.7. Version 1.0.3

A bug fix release, no new features were added.

5.8. Version 1.0.2

The following new features were introduced in DCMMS version 1.0.2:

Removed the "Valve Replacement" workorder type.
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Added the following workorder types:

* Flooding

« Damaged Installation

e lllega Use
*  Wrong Bill
* NoBill

e Subscription Change

e Unregistered Payment

Improved tranglation system.

New maintenance type "No action: Workorder duplicated".
Workorder aging report.

Improved user interface.

Improved landmark tool.

Italian and Thai localizations.

Bug fixes.

Improved documentation.
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